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Frequently asked questions




The ETDR Services What ETDR services are available at K-State?

K-State offers various types of support for ETDR. Students may access downloadable templates in Microsoft Word and LaTeX formats and information about how to use the templates to format their master’s theses, doctoral dissertations, and master’s reports. There is a downloadable ETDR Handbook (PDF) that may be used for reference.

What kind of help can I get, and how do I access that help?

If you need help on how to use the templates or to troubleshoot issues, contact the IT Service Desk to schedule one-on-one consultations: Submit a Ticket, or Start a Live Chat.

When should I use the ETDR services? Is last-minute support available?

Access ETDR services after trying to resolve the issue yourself. In general, it helps if you schedule sessions with sufficient lead-up time. During run-ups to ETDR submittal deadlines, many students will need help at the same time. Last-minute support may or may not be available.

Is there a cost for ETDR services?

There is a submission fee at the Approval to Schedule Final Examination form to the Graduate School stage and a $100 ETDR fee will be added to your university account at this time to support ETDR services.

What if I feel like I need more help beyond what is available on campus?

In such cases, it would be important to consult with the master’s or doctoral committee for further advisement. For those who may go to commercial services, it is always caveat emptor (let the buyer beware).



 



ETDR Instructional Videos These short video clips cover the most common questions and how to address them. 



 



Why use an ETDR template? Why shouldn’t I use a template shared by another graduate student? 

Using a shared template rather than downloading a new one can result in functionality problems. Many times these templates are broken, incorrect, or outdated. To avoid these issues, be sure to download and use the Graduate School's Word or LaTeX templates rather than one inherited from another graduate student.

Why are graduate students encouraged to use templates (in Word or LaTeX) for the theses, dissertations, and reports? What benefits do templates offer?

Graduate students are not required to use the provided templates for the theses, dissertations, and reports. However, these templates enable the following:

	placeholder text for required elements in a formal thesis, dissertation, and report
	correct formatting to enable the automatic creation of a Table of Contents (based on text style)
	correct formatting to enable the automatic creation of a List of Figures, List of Tables, List of Abbreviations (optional), List of Terms (optional), List of Equations (optional)
	the shading of field codes that enable automated chapter, caption, and other automatic labeling


There are many moving parts in theses, dissertations, and reports, and having a template helps ensure there are as few mistakes as possible.

How might I use a template during the proposal phase of my research? How could that possibly benefit my work?

Some graduate students download an ETDR template during the proposal phase of their research, and then use the structured file to present chapters 1 – 3. This file helps explain their work and methodology to their supervisory committee. Once their work is approved, they can continue to use the file for writing their findings, data, and analyses, for the complete thesis, dissertation, or report.

If I do not use a template until after I have completed my work, what is the best way to transfer contents over to the template? What are some common mistakes to avoid in this transfer?

Some graduate students write their work outside of the templates initially and then move their work into them when their research and writing are complete. This approach works fine, as long as some important rules are followed:

	When copying text from another file, highlight the original text, and then paste into Word using the destination formatting option.
	If the destination formatting option is not available in your version of Word, remove the formatting from the text using a tool like Apple Notes in Mac or Notepad in Word before pasting it into Word.
	Ensure styles are correct by reviewing the copied text in the destination file using the Styles Pane found on the Home tab.
	Make sure images are not compressed to avoid lower quality images. The pre-set on the Word templates help ensure high quality image handling. 
To set, do the following:
	On the File tab, click Options and then click Advanced.
	Select the Do not compress images in file option.
	On the Default resolution menu, select High fidelity before clicking OK.
[image: Image showing window where you can adjust image quality settings.]



	Ensure the resolution of your images are at least 350 dpi ppi (dots per inch, pixels per inch), and higher if required to convey the visual information.
	Do not copy tables and figures (images, maps, photographs, diagrams) along with the text.
	Insert figures individually and use the Insert tab to do so.
	Ensure the figures are high-resolution (larger than 350 dots per inch / dpi), with the CMYK color format (not RGB).
	Add tables using the table format (not a visual screenshot).





Does it matter if I have a Windows operating system or a Mac operating system? Do the template files still work the same?

The Word templates work in both the Windows and Mac operating systems. They also work in the cloud versions of Word, but the cloud versions do not have the same References capabilities as the Word version installed on your computer (rather than working in the cloud, use the application on your computer for edits).

How does the LaTeX ETDR file work? If I have a preferred LaTeX editor, may I use that instead of the one you suggest?

There is one LaTeX ETDR file, downloaded as a .zip file, that is used for theses, dissertations, and reports. The main file is etdrtemplate.tex. Depending on the included sections, a student may piece together master’s theses, doctoral dissertations, and reports. There are clear directions “commented out” in the various sections. The LaTeX file may be edited with various editors installed on your computer or using cloud-based editor tools. For more information, see the ETDR Handbook (PDF).



 



Appendices What is an appendix?

An appendix is a section of material at the end of a thesis, dissertation, or report. These contain informational materials relevant to the main document but not considered critical to include in the main document body.

What goes into appendices?  How are appendices sequenced?

What is considered appropriate for an appendix vs. another part of a document depends in part on the discipline and the particulars of the research.

An appendix may contain the following:

	a research instrument
	an analytics codebook
	photos
	supplementary data
	slideshow slides, and others.


Appendices can be labeled:

	in descending order to the material, with the most important information in Appendix A, B, C, in that order.
	in the order in which they appear in the body of the thesis or dissertation. For example, the first time an Appendix is listed in the Methodology, it would be listed as Appendix A. Subsequent labeling would be Appendix B, C, etc.


Often, appendix parts are titled, for easier use by readers.

How are appendices used?

Readers use appendices to more thoroughly understand the research work documented in the thesis, dissertation, or report.

While appendices are considered supplemental to the body of the document, the elements should be built with the same high professional standards as applied to the rest of the document.



 



Supplemental Files What are supplemental files for a thesis, dissertation, or report?

ETDRs may be supplemented with files outside of the main thesis, dissertation, or report. These are digital and digitized files uploaded into the repository with the main document. These contents are available for user download along with the main file.

What are some common types of supplemental files that accompany theses, dissertations and reports?

Supplemental files may include various types of accompanying information: relevant datasets (particularly those too large to include in data tables), slideshows, image sets, videos, audio files, letters, documents, testimonials, and others. 

Distributed supplemental files should be shared in abidance with privacy laws, intellectual property laws, and other consideration, since such files are being distributed or published through the repositories.

What should I consider when I create supplemental files? What sort of file formats should I use, and why?

The supplemental files should be in typical or even universal file formats, so they are most widely available. Some common file format types include:

	Supplemental File Types	File Format Types
	text	.txt, .rtf, .pdf, .docx
	imagery	.jpg, .png, .tif
	audio	.mp3
	video	.mp4
	spreadsheets	.xlsx, .csv


Based on practices in particular disciplines, the preferred file types may vary.

What is an informative name for a supplemental file?

Supplemental files should be named in a way that represents the contents, so those who read the file name should have a sense of what the file contains and how that file is relevant to the research. For example, focusgroupaug102020.mp4 is more informative than fg1.mp4. Supplementary files should not be generically named. The files should be shared with a sense that there will be recipients using the files.

For more details see https://www.k-state.edu/grad/academics/etdr/write/supplement.html



 



Intellectual Property Rights What is copyright, and why should I be aware of intellectual property rights?

Copyright refers to a person’s legal right to what they’ve created (written, performed, drawn, recorded, published, etc.), for a particular period of time. Copyright is part of intellectual property rights, encoded into law and practice.

See https://www.k-state.edu/grad/academics/etdr/write/copyright.html for more information.

How do I protect my own copyright when I release my thesis, dissertation, or report on a public repository?

The creator of a thesis, dissertation, or report, owns copyright to their work at the moment of creation, under the Berne Convention. They can indicate copyright within the file (included in the templates). When the student shares their work on a repository, they can indicate the level of copyright release or licensure at that moment.

If a work can be monetized, the thesis, dissertation, or report may be embargoed, and the underlying research may be recorded as part of a patent application. The embargoing process is a no-cost one. The patent process is not a low-cost endeavor, with average patent costs from $5,000 - $15,000 and higher.

Is there a cost for copyrighting my ETDR?

Students are not required to copyright their work; however, they are encouraged to do so. Registering for copyright for an ETDR involves nominal costs. Please see Copyright Information for Graduate Students for more information.

What should I do if I need to embargo my thesis, dissertation, or report, for a particular period of time?

See Embargo your ETDR for more about embargoing a thesis, dissertation, or report.

How can I benefit from my research work even if my thesis, dissertation, or report has to be embargoed?

Your embargoed work creates a record that is linked to you even though the finer points of your work may be hidden from the public for a time, until you can set up patent or other protections for your work. When you are applying for a job with a potential (trusted) employer, you may still share your work along private channels.



 



Figures and Visuals in ETDRs What are some common types of figures and visuals used in theses, dissertations, and reports?

The common types of figures and visuals in ETDRs depend in part on common practices in various disciplines. These may include data plots, diagrams, maps, photos, screenshots, or other visuals. These are often used along with data tables (which are not the same as figures).

How should I process digital visuals for inclusion in theses, dissertations, and reports? Why?

	Digital visuals should be at least 350 dots per inch / pixels per inch (dpi, ppi), for sufficient resolution for print.
	The color processing should be CMYK (cyan, magenta, yellow, black) for print processing. Do not use RGB (red, green, blue).
	For print publication, .tif is the most common digital image type. However, because of file size considerations, .jpg is generally suggested for theses, dissertations, and reports, because .jpg files tend to be relatively smaller than .tif files.


How should figures be formatted in theses, dissertations, and reports?

Figures should include captions and labels.

Captions are used to automatically number figures in a thesis, dissertation, or report template and should begin with the chapter number (if chapters are used), followed by a period, and the number of the figure. For example, the first figure in Chapter 2 would be: Figure 2.1. Name of the Figure. Create figure captions by selecting the image, going to the References tab, and then clicking Insert Caption. Once figure captions are set up, the List of Figures will update automatically.

Figure labels usually go below the image.

What is the best way to write figure captions?

Figure captions should be representative of the visual depictions. Check within your discipline to learn what common professional practices are for captioning. The captions should be informative and consistent throughout.



 



Tables in ETDRs What are some common tables used in theses, dissertations, and reports?

Tables are commonly used to represent quantitative data and used to represent categories.

How should tables be formatted in theses, dissertations, and reports?

Tables should include captions and labels.

Captions are used to automatically number tables in a thesis, dissertation, or report and should begin with the chapter number (if chapters are used), followed by a period, and the number of the table. For example: the second table in Chapter 4 would be: Table 4.2. Name of the Table. Create captions by selecting the table, going to the References tab and then clicking Insert caption. Once table captions are set up, the List of Tables will update automatically.

Table labels usually go above the table.

What is the best way to write table captions?

Table captions should be informative of the data contained within the table. Check within your discipline to learn what common professional practices are for captioning. The captions should be informative and consistent throughout.  



 



Research Source Citations How do I know what method of research source citations I should use?

The discipline and profession usually have one or two accepted methods of source citations. Review other theses, dissertations, and reports in your area, and check with your committee if necessary.

How do I make sure in-text source citations are correct?

You will need to review the respective parenthetical citations for accuracy and consistency. There is not an automated way to check (currently).

If you are using a third-party online bibliography tool, pay special attention to the respective handling of information. Sometimes, such tools will insert URLs and other versions of citations, particularly if the user has erroneous settings on the tool or if they export the citations into the Word file incorrectly.

How do I make sure bibliographic listings or references are correct?

You will need to review the bibliographic or references listings for accuracy and make sure each cited source is represented correctly based on the type of source you are using.

If you are using a third-party online bibliography tool, pay special attention to the respective handling of information. You may have to conduct further research to ensure all required information is included in the source citation.

If I use an online bibliographic tool, how can I make sure the citations are correct?

The only way to see if the in-text and bibliographic citations are correct is to review each one and to make the necessary changes. 

What are some common mistakes with research source citations?

The most common mistakes in research source citations are:

	citing a source citation in the body of a thesis, dissertation, or report, but having no counterpart in the bibliographic listing, or vice versa. 
	assuming that an online bibliographic tool is 100% accurate and not reviewing the citation formatting for inaccuracies.
	citing the wrong source.


It can be difficult to be fully accurate in formatting a wide range of sources. It can help to set aside some dedicated time to review the source citations closely.



 



Accessible ETDRs How do I make sure all the elements in my thesis, dissertation, or report are accessible?

File accessibility refers to their level of usability by people with varying levels of perception. For example: If a person has visual acuity challenges, can they still access the informational contents of the thesis, dissertation, and report?

Making an accessible ETDR involves enabling multiple channels of conveying information:

	shared imagery should include an alternate text description.
	audio and video files should include closed captioning and / or transcription.
	choropleth maps that use color intensity to convey information should also use text labels, so the information is clear even if a person is colorblind.


The visual channel is not used alone; the audio channel is not used alone. Information is provided using multiple modalities for multiple perceptual channels.

Another approach is to ensure that the same information is presented in different ways.

How do I ensure that an image is accessible?

The key to ensuring an image (a figure, a map, a diagram, a photo, etc.) is accessible, is to include informative alternate text descriptions.

In Word, alternate text descriptions can be created by right-clicking an image, selecting Edit Alt Text, entering the alt text, and then clicking the Generate a new description for me button.

[image: Image of the Alt-Text window that opens. ]

How do I ensure a data table is accessible?

Data tables should:

	have clear column and row headers
	have an informative table name. The lead-up text to the table and the lead-away text to the table (the surround) should also be informative.
	be coded so when a screen reader is reading the table contents, each cell’s column and row headers are clear.
	have sizes that are manageable for clarity.


How do I ensure audio and video files are accessible?

If you include audio and video, include transcripts for each. If you have closed captioning that goes with the audio and video files, share these files with the captioning (timed text) included. The captioning should be human-vetted and revised for accuracy.

Is there an automatic way to test for accessibility in my file?

Currently, there is no automated tool that enables accessibility assessment in a Word or LaTeX file.



 



Formatting ETDRs What if I do not like the font used in the template? Can I changed it?

It is possible to reformat the templates by going to the Styles area on the Home tab, right-clicking a particular style (Heading 1, Heading 2, body, etc.), clicking Modify, and then making the change. The change should be made centrally, not by highlighting the text and changing the font type and size in the Font area because doing so can break the coding in the templates.



 



Auto-Numbering Subheadings How do I auto-number subheadings (acknowledging the chapter numbers and then sub-numbering)?

In some disciplines (particularly various science-based ones), each subheading (Header 2, Header 3, Header 4, etc.) is numbered as a subsection. The ETDR Word templates already have the chapter auto-numbering set up.

To set up the subheadings:

	In the template, click a chapter heading (Header 1 style) and then on the Home tab, click the the Multilevel List button. 
[image: Image of Multilevel List button.]
	Select the 1 Heading 1, 1.1 Heading 2, 1.1.1 Heading 3 list button.
[image: Image showing which list to click and where to click Define New Multilevel List.]
	Click the Multilevel List button again and then click the Define New Multilevel List…link.
	For Level 1, input the “Chapter –“ to maintain the labeling of the chapter with the proper fontface.
[image: Image showing the Define Multilevel List window]

Note: Sometimes, you have to manually enter the “formatting for number" information. Copy “Chapter,” and then paste it in front of the greyed number in order to not overwrite the auto-numbering (represented as field code with the gray highlight).
	Click the Set for All Levels button and then set the correct indentation levels.
	Go to Level 2 and then click Set for all Levels.
[image: Image showing where to set formatting for each level]
	Repeat this until you reach whatever level of subheading you’re using.
Note: Heading 6 is reserved for the Appendix header in the templates. Also, be sure to preserve the chapter headers.


Autonumbered subheadings doctoral dissertation (.docx)



 



Outputting your ETDR as a PDF from Online Word An important feature of the ETDR templates are navigable Table of Contents, List of Figures, List of Tables, etc. to the particular section contents, figures, or tables) and this must remain in place when outputting a PDF from Microsoft Word. 

In most cases you can use Word > Print > and then selecting PDF to output your document. You can also choose Save As > PDF in Word. 

You can also use Adobe Acrobat to export the Word document to PDF.  In some cases, these steps can result in non-clickable links however. 

Another way to do this is to go to your K-State provided online version of Microsoft Word (Visit https://webmail.ksu.edu -> MS Word icon in the grid/waffle menu in the upper left)…

	Open the ETDR file (Word format)
	Go to "Save as"
	Select "Download as PDF"


[image: download PDF ETDR]

This seems to work even if you do not have a commercial version of Adobe Acrobat or Adobe Acrobat in the Cloud.

To test your file, open the PDF file using Adobe Reader.  (Do not use a web browser to open the file as the browser may give the file additional powers that it does not natively have.)  Navigate to the Table of Contents, List of Figures, or List of Tables.  When you hover the cursor over any items in these sections, the cursor should turn into a small hand, and when clicking on the titles, the file should enable you to jump to the target contents. 



 



Related Deadlines How do the deadlines work for submitting a work to K-REx?

Deadlines related to graduation and ETDR submission are announced on the K-State Graduate School's ETDR Submission page each semester.

How long does the Graduate School usually take to review my file?

The Graduate School may take 3 days to a week to review submitted ETDR files.

How much time will I have to revise the file once I have feedback from the Graduate School?

The amount of time you have to revise the file once you receive feedback depends on how close you are to the target deadline. 



 



Signoffs on the Theses, Dissertations, and Reports How will my major professors or co-major professors sign off on my thesis, dissertation, or report work?

Your major professors or co-major professors will sign off on your work via K-REx.

Make sure your thesis, dissertation, or report has been signed off by your committee before finalizing your ETDR for submittal.

What requirements will the Graduate School have for my thesis, dissertation, or report?

The Graduate School requires that graduate students follow the defined formatting requirements for the thesis, dissertation, or report. Please view the ETDR Formatting Checklist for standards.



 



Submitting your ETDR Do I have to have my ETDR approved before I actually submit it to K-REx?

No. Once your final exam ballot and final ETDR ballot have been submitted to the Graduate School, submit your ETDR to the K-State Research Exchange (K-REx).

ETDR Fees

There is a $100 ETDR submission fee which replaces the previous binding fee and printing costs and helps support ETDR systems and services. There is no fee for doctoral students to submit their dissertation to ProQuest. There is a $55 fee if you register for copyright through UMI (optional). For details, see the Fees.

I saved my thesis, dissertation, or report and supplementary files into one folder and saved that as a .zip file. Can I just upload this one zipped file?

No. Theses, dissertations, and report have to be submitted as a .pdf files. The supplementary files are usually submitted singly into K-REx.

I started my submission on K-REx. However, when I go to “All Electronic Theses and Dissertations” in the Choose Collection menu, the menu is blank.

This occurs if you have more than one email address in the K-REx system. Contact Angie Pfizenmaier (785-532-6191) for support in correcting this issue.

I received an email indicating that my ETDR submission was rejected? What do I do now?

Usually, this occurs because of minor issues with the file, such as missing data or formatting issues. The email will describe the issue(s), so you can make the corrections. Resubmit your ETDR after the corrections are made. The prior information you submitted will still be maintained in K-REx.

Do I have to submit my ETDR to both K-REx (K-State) and ProQuest (UMI)?

Master’s students have to submit their thesis to K-REx. Doctoral students have to submit their dissertation to both K-REx and ProQuest.

When can the general public discover and download my ETDR?

The ETDR files and supplementary materials (if included) should be available a few days after they are approved by the Graduate School.

Can I submit a different version of my work after my ETDR has been accepted and finalized?

Once work has been approved and submitted in finalized format, a different version cannot be submitted. In exceedingly rare circumstances, it is possible a change may be approved on a case-by-case basis.



 



ProQuest Repository What is ProQuest?

ProQuest is a publishing company that, in part, archives master’s theses, doctoral dissertations, and master’s reports.

Why do doctoral dissertations need to be archived in ProQuest?

For K-State graduate students, only doctoral dissertations are archived in ProQuest. They need to be archived to enable a publicly accessible work to showcase the research, student capabilities, and university reputation.

Are there related costs in submitting a thesis, dissertation, or report to ProQuest?

Submitting a doctoral dissertation to ProQuest does not involve cost. However, if the student wants to apply for copyright through ProQuest, there is a nominal cost involved. See Submit Your Dissertation to ProQuest for more information.
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